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Welcome to Concur Invoice 

Concur Invoice is a cloud-based tool that integrates invoices with T&E payments within a single system. Concur 
Invoice gives you one view to manage all your business spend – from purchase request through payment. 

Section 1: Logging on to Concur Invoice  

How to…  Additional Information 

1. Log onto Concur Invoice following your 
company’s logon instructions. 

 If you are not sure how to start Concur Invoice, 
check with your company’s system administrator. 
When starting Concur Invoice, you will first see 
the Login page. 

When logging onto Concur Invoice Service, 
remember that your password is case sensitive. 
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Section 2: Creating a Purchase Request 

The Concur Request feature is designed to help businesses control expenses by requiring employees to obtain 
approval before incurring travel or other expenses. 

How to…  Additional Information 

1. On the SAP Concur home page, place your 
mouse pointer over New. 

 The drop-down menu displays. 

2. Click Start a Request. 

3. From the Purchase Request drop-down menu, 
select Request Items, and then select Add 
New Item. 

  

 

 

4. Click the Type drop-down arrow to select 
whether this request is for Goods or Services. 

  

5. Enter the name of an existing vendor to search 
for and select from the saved list or click 
Request New Vendor to enter the details for a 
new vendor. 

 If you request a new vendor, enter the appropriate 
vendor details and then click Apply to upload 
additional documentation or OK to save the vendor 
information as is. 

6. Complete the required fields for the new item 

(indicated with a red bar), and then click Save. 
 Your company defines which fields are required. 

Items that are pending a purchase request appear 
in the Cart Items section. 

7. Click Request at the bottom of the page.   

8. Enter a Description, and then click Save.   

9. To use the default Ship To location, click 
Submit. 

 To change the default Ship To location, click the 
Ship To link and modify the address. 
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Section 3: Approving a Purchase Request 

As a Request approver, you can review a purchase request sent to you for review and approval and then: 

▪ Approve the request. 

▪ Approve the request and forward it to another approver (if your company is configured to use this 
workflow feature). 

▪ Send the request back to the user with a comment (to perhaps change and resubmit the request) or 
decline the request. 

How to…  Additional Information 

1. On the SAP Concur home page, in the My 
Tasks section, under the Required Approvals 
heading, select Purchase Requests. 

 You can also click the Approvals tab at the top of 
the home page and then select Purchase Requests. 

The Approvals page appears with a list of all the 
purchase requests that need your review and 
approval. 

2. Select the appropriate Request No. link, and 
then complete one of the following three 
steps: 

▪ Review the request and then select 
Approve. 

▪ Review the request and click Approve & 
Forward. 

▪ To send back a request for correction, click 
Send Back. 

  

 

 

To attach additional documentation to a selected 
request, click Actions and then select Upload 
Image. 

If your company has multiple steps in the approval 
process, then select Approve & Forward to send it 
to the next approver in the workflow. 
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Section 4: Creating a New Payment Request from an Existing Vendor   

The basic steps in the payment request process are: 

1. Create the payment request – first selecting or adding a vendor, and then providing request-level 
information (such as the payment request name, invoice number and date, amounts, and comments). 

2. Itemize the payment request – selecting the expense type, such as "Computing Equipment". 

3. Distribute or allocate the payment request across departments. 

4. Attach an image of the invoice to the payment request. 

5. Review and submitting – reviewing the information on the payment request for accuracy and then 
submitting it for approval. 

6. Unassign the request (optional) for reassignment to the employee associated with the request. 

 

Step 1: Creating a payment request  

How to…  Additional Information 

1. On the Invoice tab, click Create New Request.  The Create New Payment Request page appears. 

2. Use the Search fields to find and select the 
appropriate vendor or select it from the entire 

Vendor List by clicking the Search icon . 

 The Enter Invoice Details page appears. 

3. Complete the required fields as indicated with 
red bars and the optional fields as directed by 
your company, and then click Save. 

 Scroll through the Invoice Details page to view all 
the available fields. 

 

 

http://www.concurtraining.com/customers/tech_pubs/$onlineHelp/en/InvShrEmp/InvProEmp/Content/ConcurFlarePool/invoice_submitter_payment_request_unassign.htm
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Step 2: Itemizing a payment request  

How to…  Additional Information 

1. In the Itemization Summary section of the 
page, click Add Item. 

  

2. Select the appropriate expense type, such 
as Furniture and Fixtures. 

  

3. In the Add Item section, complete all required 
fields (indicated with red asterisks) and the 
optional fields as directed by your company and 
then click Add. 

 The fields that appear on this page are defined by 
your company. 

4. Continue adding items until all the items 
(expense types) are represented and then 
click Save. 

 The Amount Remaining to be Itemized balance will 
be $0.00 when all the items have been correctly 
added. 

 

 

Step 3: Distributing a payment request 

After creating a new payment request, you can distribute the amount of the expense. Distributing allows you to 
allocate a portion of the transaction to different cost centers, departments, or locations based on accounting 
requirements.  
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How to…  Additional Information 

1. In the Itemization Summary area of the page, 
select the appropriate checkboxes (on the left 
side of the page) for the items you want to 
distribute. 

  

2. Click Distribute and then Distribute Selected 
Items.  

 The Distribute Selected Items page appears. 

3. Click Distribute By and select Percentage or 
Amount as the distribution type. 

  

4. Click Add.   

5. Complete all the required fields (indicated with 
red asterisks) and the optional fields as directed 
by your company. 

 The fields that appear on this page are defined by 
your company. 

6. Repeat steps 4-5 to add as many distributions 
as you need and then click Save. 

 With each additional allocation, the system will 
automatically distribute the percentage evenly 
between the departments. You can manually 
adjust the Percentage or Amount fields as needed. 

 

 

Step 4: Attaching an image to a payment request 

Your company might require that an image of the payment request invoice be attached to the payment request 
prior to submission. 
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How to…  Additional Information 

1. On the Payment Request page, 
click Actions and then click Upload Image. 

 The Upload Image window appears. 

2. Click Browse.   

3. Navigate to the image file and then click Open.  Optional: Repeat step 3 for additional images up to 
10 (for this session). 

4. Click Upload and then click Close.  The amount of time required to upload the images 
depends both on the size of each file and the 
connection speed. 

You can view the image later by opening the 
request and then clicking View Invoice on the 
upper right side of the page. 
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Step 5: Reviewing and submitting a payment request  

If your company uses a centralized process, your Accounts Payable (AP) department might create payment 
requests for employees before assigning them to the correct Invoice Owner.  In this case, as the Invoice Owner, 
you will review and submit the request, if it is correct, or assign the request back to AP if changes are needed. 

How to…  Additional Information 

1. On the Invoice tab, select the payment request 
that you want to submit for approval. 

 The Payment Request List shows your requests. 
From the View drop-down menu, you can select 
the types of requests to view. You might need to 
select All Requests to determine the current status 
of your request. 

2. Review the payment request for accuracy, make 
any necessary changes, and then click Save. 

 If you do not make any changes to the payment 
request, you do not need to click Save. 

3. Click Submit Request.   If the request cannot be successfully submitted, a 
message appears that describes the request error. 
Correct the error or, if help is required to complete 
the task, consult your Invoice administrator. 

 

 

Step 6: Unassigning a payment request (optional) 

If a request doesn’t belong in your queue or is invalid, you can unassign it to allow your back office staff to act 
on it, such as reassigning it to the appropriate invoice owner. 

How to…  Additional Information 

1. On the Payment Request List page, select the 
appropriate payment request and then click 
Actions. 

  

2. In the Actions menu, select Unassign.  The Unassign Request window appears.  

3. In the Comment field, enter an explanation as 
to why you are unassigning the payment 
request, and then click OK.  
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Section 5: Creating a Recurring Payment Request  

You can easily set up a payment request to run on a recurring schedule that you specify. 

How to…  Additional Information 

1. Open the appropriate payment request, click 
the Actions drop-down menu, and then select 
Create Recurring Request. 

 After you create a recurring request, you can 
modify the payment schedule by clicking Edit 
Recurring Request. 

2. Select What is the frequency of the recurring 
request from the drop-down menu. 

 The system duplicates the recurring request, which 
appears on the Recurring Requests page (access by 
going to the View menu on the Unsubmitted 
Requests page and selecting Recurring Requests). 
This duplication occurs on a regular basis specified 
by the offset value (the default is 14 days prior to 
the payment date). 

3. Select What day(s) of the month is the 
payment for the recurring request due from 
the drop-down list. 

  

4. Select the Start and End dates for when this 
recurring request will be effective and then 
click Save. 
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Section 6: Approving a Payment Request 

As an Invoice approver, you can review a request sent to you, and then: 

▪ Approve the payment request. 

▪ Attach additional receipt images or documentation to the request. 

▪ Send a request back to the employee to modify, and then resubmit the request. 

How to…  Additional Information 

1. On the SAP Concur home page, in the My 
Tasks section, under the Required Approvals 
heading, select Payment Requests. 

 You can also click the Approvals tab at the top of 
the home page and then select Payment Requests. 

The Requests Pending Approvals page appears 
with a list of all requests that need your review and 
approval. 

2. Complete one of the following three steps: 

▪ To approve a request as is (without 
opening it and reviewing the details), 
select the appropriate request and then 
select Approve. 

▪ To review the details of the request, 
double-click the appropriate request, 
review it for accuracy, and then click 
Approve or Approve & Forward. 

▪ To send back a request for correction, 
double-click the appropriate request and 
then select Send Back. 

 To attach additional documentation to a selected 
request, click Actions and then select Upload 
Image. 

 

If your company has multiple steps in the approval 
process, then select Approve & Forward to send it 
to the next approver 
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Section 7: Requesting a New Vendor 

If the vendor for your payment request is not located within the system, you can submit a new vendor request. 

How to…  Additional Information 

1. On the Invoice tab, click Create New Request   

2. On the Create New Payment Request screen, 
click Request New Vendor. 

  

3. Under General Vendor Information, complete 
the required fields as indicated with a red bar 
and then complete on of the following options: 

▪ Click OK to submit without further action 
the new vendor request. 

▪ To attach documentation before 
submitting the new vendor request, click 
Apply and then click Upload Images in the 
Actions menu. 

  

 

 

 

 

After clicking Apply, the Actions menu is activated, 
and you can then attach documentation to the new 
vendor request. 
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Section 8: Assigning a Purchase Order to a Payment Request 

If a purchase order has been scanned into the system by Concur Invoice Capture, you can assign it to a payment 
request. 

How to…  Additional Information 

1. On the Invoice tab, click Create new Request.   

2. Enter the Purchase Order Number that you 
want to assign. 

  

3. Click the Purchase Order tab and in the 
remaining Invoice Details section, enter the 
required fields as indicated with red bars, and 
then click Save. 

 You can enter the Expense Type, Line Description, 
and Amount for each line item and then click Save 
or you can copy the line items from the PO as 
shown in steps 4 and 5. 

4. Click the Matching Summary tab, click Copy 
Items from PO. 

  

5. Select the check box for the items you want to 
add and then click Copy. 

 The line items are now assigned to the payment 
request. 

6. Click the Payment Request tab and then click 
Submit Request. 
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